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Application note

How to use CMake in STM32CubelDE

Introduction

This application note describes how to control the software compilation process using the CMake utilities for C/C++ projects in
the STMicroelectronics STM32CubelDE integrated development environment.
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General information

1 General information

STM32CubelDE supports STM32 32-bit products based on the Arm® Cortex® processor.

Note: Arm is a registered trademark of Arm Limited (or its subsidiaries) in the US and/or elsewhere.

arm

1.1 Purpose

STM32CubelDE offers the user-requested CMake feature, which developers can leverage for their developments
in the STM32 MPU and MCU ecosystems.

1.2 The use cases in this document

In the STM32CubelDE context, a user can compile C/C++ projects using either the makefile or the CMake
solutions. This document details the use of CMake for two use cases:

. The user wants to work with an existing CMake project structure
. The user wants to start a CMake development from scratch
1.3 Compatible toolchain

The STM32CubelDE CMake support presented in this application note works with the following minimum version
of the toolchain:

. STMicroelectronics STM32CubelDE v1.13.0

1.4 Prerequisites

CMake must be installed on the user's computer. The compatibility with STM32CubelDE is from CMake v3.13
onwards.
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2 Create projects

2.1 Creation with an existing CMake project structure

Creating a new project with an existing CMake structure offers an easy way to use an already developed or a
downloaded project or library for use in STM32CubelDE. To do so, start by following the steps below:

. Select [File]>[New]>[STM32 CMake Project]
Figure 1. CMake project creation

File Edit Source Refactor Navigate Search Project Run Window Help
New Alt+Shift+MN > Makefile Project with Existing Code

Open File... C/C++ Project
2 Open Projects from File System... [I STM32 Project
Recent Files 5 [ STM32 Project from an Existing STM32CubeMX Configuration File (.ioc)
[ STM32 CMake Project 3
Close Editor CulsW = project... ué
Close All Editors Ctrl+Shift+W Convert to a C/C+.Creates a new STM32 CMake Project | E
. Select [Project with existing CMake sources]

Figure 2. CMake project types

[[3 New STM32 CMake Project O X

Project with existing CMake sources

Creates a new STM32 CubelDE CMake project using existing CMake sources

O Project from CMake template
(® Project with existing CMake sources

>
@ < Back Next > Finish Cancel %
3
. Select [Next >]
The next wizard page allows the setup of a CMake project in two different ways:
. Project creation inside an existing CMake project structure (refer to Section 2.1.2)
. Project creation external to an existing CMake project structure (refer to Section 2.1.3)
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2141 CMake project as a subproject

Alternatively, to create a CMake project as a subproject in a more complex project structure, use the following
context menu option.

Figure 3. CMake project as a subproject

File Edit Source Refactor Navigate Search Project Run Window Help
N A ~vigivae vy vy @vievOvy@hvin i@y viRETTIH

% Project Explorer &7 1 =0
b= 6283A1_“' P W 2 P
New )
Go Into
Show In Alt+Shift+W >
st Ctrl+C
Paste Ctrl+V
¥ Delete Delete
Move...
Rename... i}
1 Import...
i Export...
%1 Refresh i

Close Project
Close Unrelated Project

© Run As p)
1 Debug As >
Team >
Compare With >

Restore from Local History...
[Z Create a STM32 CMake project using existing CMake sources

Configure >

DT72056V1

Then, for a project creation inside or external to an existing CMake project structure, refer to Section 2.1.2 or
Section 2.1.3.
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21.2 Creation inside an existing CMake project structure
To create a new project inside an existing package that was already downloaded or created, do the following:
. Specify a name for the project.
. Uncheck [Use default location].

. Use the [Browse...] button and select the root directory of a CMake-based project. This disables the
[Source directory] field since the project location and the CMake source directory are the same.

. Specify the path to the build directory to be used for the CMake configuration. By default, the build directory
is config default relative to the CMake source directory.

Figure 4. Project creation inside an existing CMake project structure

[I3 New STM32 CMake Project O X

Project with existing CMake sources

@ Specified build directory already exists and might be corrupted/overwritten by this
configuration

Project name: ‘ aws ‘

[ ] Use default location

Location: ‘ ¢ 5 larrati b beew ey jif\@amazon-freertos | |Br0wse...|

Source directory: | C\Users\ \git\amazon-freertos Browse...

Use default build directory
Build directory: C:\Users\, \git\amazon-freertos\config_default Browse...

@ < Back H Next > Finish Cancel
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. Click on [Next >].
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213 Creation external to an existing CMake project structure

In this other way to set up the project, it is created in the user's workspace. This is useful in the case of a complex
project structure to link the existing package from the source directory to the project.

. Specify a name for the project.

. Specify an empty directory for the project. Keep [Use default location] checked so that the project is
created inside the current workspace directory.

. Use the [Browse...] button and select the root directory of a CMake-based project. The selected directory

is linked into the project.

. Specify the path to the build directory to be used for the CMake configuration. By default, the build directory
is config default relative to the CMake source directory.

Figure 5. Project creation external to an existing CMake project structure

[I3 New STM32 CMake Project O X

Project with existing CMake sources

@ Specified build directory already exists and might be corrupted/overwritten by this
configuration

Project name: ‘ aws

Use default location
Location: C:\Users\ \STM32CubelDE\workspace_1.12.0.23w12_MP2-D3-A3\aws Browse...

Source directory: Cenlla ""..|'1',|'|'| malllqi'l\amazon—freertos ‘ ‘ Browse... ‘

Use default build directory
Build directory: C:\Users\ \git\amazon-freertos\config_default Browse...

@ < Back ” Next > Finish Cancel
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. Click on [Next >].

The next wizard page allows the configuration of a default toolchain and its relevant options for the created
project. This is not directly relevant for building the CMake project structure but the IDE might require this
information for certain of its features to function properly.
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. Fill in:
- The information about the MCU and core for the debugger
- The proper indexing, for instance for code completion
- The selected toolchain, which is added to the PATH variable when building the project

Figure 6. CMake default toolchain

[I New STM32 CMake Project O X

Configure default tool-chain settings for the project

Toolchain: MCU ARM GCC v

STM32 device

MCU: | STM32U545RETX [select.. |
CPU: Cortex-M33 (0) v
Core: ‘0 M ‘
S
@ < Back Next > Finish ‘ ‘ Cancel "é
g
a

. Select [Finish]
At this stage, the project is created and visible in the Project Explorer view.

2.2 Starting CMake project development from scratch

STM32CubelDE also offers the possibility to create an own user's project using CMake. To do so, proceed as per
the steps below:

. Select [File]>[New]>[STM32 CMake Project]
Figure 7. CMake project creation (alt.)

File Edit Source Refactor Navigate Search Project Run Window Help
New Alt+Shift+N > Makefile Project with Existing Code

Open File... C/C++ Project
2 Open Projects from File Systemn... [E STM32 Project
et Fles 5 [ STM32 Project from an Existing STM32CubeMX Configuration File (.ioc)
[ STM32 CMake Project s
Close Editor Crl+W | Project... §
Close All Editors Ctrl+Shift+W B (® & Ces Crea:ces a new STM32 CMake PI’OJeCti E
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. Select [Project from CMake template]

Figure 8. CMake project types (alt.)

[I3 New STM32 CMake Project O X

Project from CMake template

Creates a new STM32 CubelDE CMake project using one of the available templates

(® Project from CMake template
(O Project with existing CMake sources

@ < Back Next > Finish Cancel
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. Select [Next >]
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. Provide the information requested for the project creation:

- Specify a name for the project.

- Specify an empty directory for the project. Keep [Use default location] checked so that the project is
created inside the current workspace directory.

- Select the template to use for the project. Currently, the templates for “Executable” and “Static
Library” targeting the “MCU ARM GCC toolchain” are available.

Figure 9. CMake project from template

[I New STM32 CMake Project O X

Project from CMake template

Project name: ‘ MyProjecﬂ ‘
Use default location

Location: C\Users\iky. - n1.w\STM32CubelDE\workspace_"," .1 feeds BAE! 1= 5 \Myl | Browse...
Template: ‘Executable b ‘
S
@ < Back ” Next > Finish Cancel S
E
[a]

. Click on [Next >]

The next wizard page allows the configuration of a default toolchain and its relevant options for the created
project.
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. Select the options for the STM32 device to be used for the new project

Figure 10. CMake default toolchain (alt.)

[I New STM32 CMake Project O X

Configure default tool-chain settings for the project

Toolchain: MCU ARM GCC v

STM32 device

MCU: | STM32U575CIUx [select..
CPU: Cortex-M33 (0) v
Core: ‘0 b ‘
@ < Back Next > Finish ‘ ‘ Cancel
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. Click on [Finish]
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3 Configure and build

3.1 CMake build settings

The CMake-related build settings can be specified in the project properties:

. Select C/C++ Build available in the project properties.

. Select the CMake Settings tab.

. Select the build system in [Generator]:

- "Unix Makefiles"
- "Ninja"

. Specify the initial values for the CMake configuration step in [Other Options]. The example presented in
Figure 11 is for configuring the amazon-freertos CMake package for the B-L475E-IOTO1A STM32
Discovery kit.

Figure 11. CMake build options (Generator)
[T Properties for CMake m} *
[ type filter text | | €/¢++ Build CR SR
» Resource
Builders
~ C/C++ Build Configuration: |Dehu9 [ Active | V| | Manage Configuratiom...|
Build Variables
Environment
Logging CMake Settings E| Builder Settings| Behavior| Q§° Refresh Policy|
Settings
Tool Chain Editor Build directory: | Debug |
> C/Cr+ General Generator: Unix Makefiles ~
Project Matures
Project References CMake build type: Ninja
Run/Debug Settings CMake export compile commands: [
CMake toclchain file: | cubeide-gecc.cmake |
Other options: | |
|Rst0legefauhs| | Apply | ~
3
8
® |Apply and Closel | Cancel | E
[a]
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. Select the [CMake build type]:
- Empty (default value)
- "Debug”
- "Release”
- "RelWithDebuginfo" (release with debug information)
- "MinSizeRel" (minimum size release)

Figure 12. CMake build options (CMake build type)

AN5952 - Rev 2

Build Variables
Environment

Project Natures
Project References
Run/Debug Settings

[I Properties for CMake m} x

[ type filter text C/C++ Build Gvchv B
» Resource
Builders

wv CfC++ Build Configuration: |Dehug [ Active ] V| | Manage Conﬁgulations...|

CMake build type:

CMake export compile commands:

Legging CMake Settings | [ Builder Settings| Eehavior|  Refresh Policy

Settings

Tool Chain Editor Build directory: | Debug |
» C/Cr+ General Generator: |Uni1t Makefiles Vl

Debug

CMake toolchain file: Release
. RelWithDebuglnfo
Other options: MinSizeRel

| Restore Defaults | |

Apply |

|Apply and Closel |

Cancel |
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. Configure the parameters as shown in Figure 13, when working with CMake projects in STM32CubelDE, to
mitigate indexer issues resulting from CDT™ limitations.

Figure 13. Compilation database parser

m Properties for Cmake

m] x
type filter text Preprocessor Include Paths, Macros etc. Grov §
> Resource

Builders
s C/C++ Build Configuration: | Debug [ Active ]

| ‘Manage Configurations..|

v C/C++ General
» Code Analysis
Documentation

Entries | <= Providers

File Types

Formatter {# CDT User Setting Entries Clear Entries
Indexer E| Exported Entries from Referenced Projects [ Shared |

Language Mappings i COT Managed Build Setting Entries [ Shared |

Paths and Symbols

&, MCU ARM GCC Built-in Compiler Settings
Bicprocesoyinclidiela! [ ®, €DT Cross GCC Built-in Compiler Settings [ Shared |

Project Natures DT GCC Build Output Parser [ Shared ]

[] ®, coT GCC Built-in Compiler Settings [ Shared ] '

[ ®, COT GCC Built-in Compiler Settings Cygwin [ Shared |

Project References
Run/Debug Settings

Move Down

Language Settings Provider Options
Use global pravider shared between projects Store entries in praject settings folder (easing project migration)
Options of global providers below can be changed in Workspace Settings, Discovery Tab.
Cotmpilation Database path (cormpile_commands.json):

File System... | | Variables...
Build parser:
Mo build output parser enabled in "Providers” ~

Exclude files not in the Compilation Database

< > | Restore Defaults | | Apply |

@ [4pplyand Close| | cancat |
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3.2 Building a CMake-based project

For CMake-based projects, the IDE build configuration management and user interfaces are similar to those for
non-CMake-based projects, including:

. Menus
. Toolbars
. Buttons

Multiple project build configurations can be created and associated with different sets of CMake settings, such as
“Debug” and “Release”.

Figure 14. CMake project manual build
File Edit Source Refactor Navigate Search F
DvHR ®~QA~vERIvidig~ &~]|
# [ Project Explor. 1 config_default

v £ aws ™M
> # Binaries o
> H Archives cmi

» @l Includes
v (& amazon-freertos -
> = config_default --

> = demos o
> =doc -
mo
» (= freertos_kernel re;
> @ libraries de|
> = projects
» = tests mo!
> = tools re:
de|
> = vendors
[¢3 CHANGELOG.md mot
El checksums.json re
= CMakelists.txt de|
[s CODE_OF_CONDUCT.md mo:
[z CONTRIBUTING.md re;
& DEPRECATED.txt de|
= directories.txt
= LICENSE __.
= Preload.cmake < >
[¢» README.md &I §
& SECURITY.md 5

LN P

During the first project build, the IDE automatically performs:

. The CMake configure step

. The setup of the CMake cache

. The build files generation into the specified build directory

Any subsequent build is performed in the build directory using the existing CMake cache.
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3.3 CMake manual configure step
The CMake configure step and build files generation can also be performed manually from:
. Either the project context menu

Figure 15. CMake project context menu

File Edit Source Refactor Navigate Search Project Run Window Help
HrHl@® -~ S ~Rinidigr@8ryE-rE it O~ Q idy viR[ETL
& lts Project Ex ~

v & aws

New >
Go Into

B Arc Open in New Window

& Incl Show In Alt+Shift+W >

o =0 E

Copy Ctrl+C
Paste Ctrl+V
% Delete Delete
Source >
Move...

Rename... F2
Import...

Export...

L E

Build Project
Clean Project
“1 Refresh F5
Close Project
Close Unrelated Project

Build Configurations >
Build Targets >
Index >
© RunAs >
% Debug As >
Team >
Compare With >
Restore from Local History...
[ CMake Configure
% Run C/C++ Code Analysis
Configure >
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=5 aws Properties Alt+Enter

AN5952 - Rev 2 page 15/20




‘— AN5952
,l Configure and build

. Or the Project menu

Figure 16. CMake project menu

File Edit Source Refactor Navigate Search Project Run Window Help
Bvd@ ®>Q{ ~vEinidig-ye~ Open Project

5 & Project Explorer Close Project
®
al” = aws G Build All Ctrl+B
.o
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= » [ Archives Build Project
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i i >
2] » tx amazon-freertos Build Working Set

Clean...

[ CMake Configure
Build Automatically

Build Targets >

C/C++ Index >

Generate Report
£ Generate Code
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IMPORTANT NOTICE — READ CAREFULLY

STMicroelectronics NV and its subsidiaries (“ST”) reserve the right to make changes, corrections, enhancements, modifications, and improvements to ST
products and/or to this document at any time without notice. Purchasers should obtain the latest relevant information on ST products before placing orders. ST
products are sold pursuant to ST’s terms and conditions of sale in place at the time of order acknowledgment.

Purchasers are solely responsible for the choice, selection, and use of ST products and ST assumes no liability for application assistance or the design of
purchasers’ products.

No license, express or implied, to any intellectual property right is granted by ST herein.
Resale of ST products with provisions different from the information set forth herein shall void any warranty granted by ST for such product.

ST and the ST logo are trademarks of ST. For additional information about ST trademarks, refer to www.st.com/trademarks. All other product or service names
are the property of their respective owners.

Information in this document supersedes and replaces information previously supplied in any prior versions of this document.

© 2025 STMicroelectronics — All rights reserved
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